
If you’re looking for the Swiss Army knife of Macintosh applications—

one program that does it all—integrated software is it. The programs

described in this chapter combine the basic software tools most people use

everyday. These tools include a word processor, a spreadsheet, a database,

drawing tools, and a communications program.

We’ll spell out why you might choose an integrated application instead of

investing in several separate, specialized applications. You’ll find out who’s

who in the market, as well as get a quick overview of which combination

of tools each package offers.

If you’ve already bought one of the two most popular integrated applica-

tions on the Macintosh—ClarisWorks or Microsoft Works—we’ve compiled

a list of tips, tricks, and shortcuts that should help you get the most out of

these leading programs.
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Getting the Works (CG)

Integrated applications offer one-stop shopping to Macintosh users who may not
want or need separate specialized applications for some of the basics. The basics we’re
talking about are word processing, database management, spreadsheets, telecommu-
nications, and drawing.

Integrated applications (each component of which is usually called a module or an
environment) offer several advantages over many individual programs:

• Price. These programs range in price from $55 to $500. You don’t have to be a
financial wizard to figure out that buying an integrated application is often less
expensive than buying a stand-alone word processor, drawing program, spread-
sheet, and so on.

• Program size. If you want or need to keep the number of applications on your hard
disk to a minimum, then having one application rather than several saves space. An
integrated application may be ideal if you have a PowerBook or Duo and want to
pack a lot of functionality into limited hard disk space.

• Integration. Because all the tools are integrated, sharing data between them and
moving among them is, for the most part, a snap.

The trade-off is that these programs often offer a limited set of features compared to
the leading stand-alone applications. Yes, the basics are here, but if you need to auto-
mate your accounts receivable department or plan to write a textbook complete with
footnotes and indexes, you may need the more specialized features that stand-alone
applications offer.

Choosing an Integrated Package (SS/CS)

The players in this software category have changed considerably since the last edition
of The Macintosh Bible. GreatWorks (Symantec) and WordPerfect Works no longer
exist. And if RagTime and HandiWorks are still around, you can’t tell by looking at
ads and mail-order catalogs. Thus, there are now only two serious contenders in the
Mac integrated software market: ClarisWorks (which is bundled with Apple’s
Performas and several Macintosh clones) and Microsoft Works.
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Although Microsoft Works owned this category for years, Works (now in version 4)
hasn’t been updated since mid-1994. Introduced in 1991, ClarisWorks has virtually
taken over this market, and has released major updates on an annual basis. And of the
two programs, only ClarisWorks has a native version for Power Macintoshes.

In this chapter, you’ll also find a discussion of Microsoft Office, a suite of programs
that Microsoft sells as an integrated package. Unlike ClarisWorks and Microsoft
Works, the modules in Microsoft Office are complete copies of three best-selling
Microsoft applications: Word, Excel, and PowerPoint.

Regardless of which integrated package you choose, there’s extensive support available,
including books, training services, libraries of macros—and the tips at the end of this
chapter. Choosing a program will depend on the combination of modules that you
need (the following table shows what features the leading integrated packages offer).

ClarisWorks ( JL)

Already the leading integrated application for the Macintosh, ClarisWorks 4 ($130,
Claris) continues its evolution with the addition of powerful new features that beg 
the question, “Do I really need to buy a Microsoft Office type of product?” By requir-
ing less memory and hard disk space, yet giving users features and power that they’ll
actually use, it becomes harder for many to justify the expense and overhead of a 
full-blown suite.

All of the environments (with the exception of communications) offer something new,
but it’s the word processor that receives the most attention in version 4. Style sheets
enable users to format their documents much faster than before. Styles can be edited,
saved, and then applied to text, paragraphs, outlines, and tables. Users can easily
access the styles via a pop-up menu on the text ruler or by using the floating style sheet

Chapter 12: Integrated Software336

POWER MAC

Integrated Offerings

ClarisWorks 4 • • • • • • some

Microsoft Works 4 • • • • • • some address book, 
calendar

Microsoft Office 4.21 • • presentations, 
data queries, 
programming
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window. Also new is the ability to have mul-
tiple sections in a document. For instance,
you could have a single column at the top of
the page and multiple columns on the lower
half. Other new layout options include end
notes and multiple headers and footers in a
document.

As more features are added, one common
concern is that ease of use may suffer.
Because many new Macintosh users get their
first taste of computing with ClarisWorks,
Assistant technology has been added to help

them create more complex documents like newsletters and home-finance spread-
sheets. When creating a new document using an Assistant, you are asked a series of
questions concerning the layout and content. After the Assistant gathers the required
information, it creates a new formatted document for you, ready to receive infor-
mation. And Assistants aren’t just for new users; experienced users can also save time
by not having to set up documents
manually. ClarisWorks also includes
many stationery documents that can
be quickly modified for common and
not-so-common tasks.

The database environment now has a
feature that most Microsoft Works
users have taken for granted (and have
often requested after making the
switch): an automatic List view. New
field types have been added to make
data entry faster and more accurate.
Although true scripting isn’t available,
a feature called FastReports lets you store sets of find and sort instructions and later
re-execute them (so you don’t need to recreate them each time). Users will appreciate
the Assistant that helps set up the dreaded mailing labels, too.

The draw environment includes a drag-and-drop art library with 500 clip art images
that you can easily add to any document. The spreadsheet environment gets a graphic
makeover with the addition of cell shading. Another nice feature is a Fill Special
command that automatically fills in day names, months, quarters, and so on, as row 
or column headings. Claris finally decided to add some scripting capabilities via
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In ClarisWorks, you can create, edit, and apply styles to
text, paragraphs, outlines, and tables.

ClarisWorks 4 Assistants help you quickly create complex documents
such as newsletters.



AppleScript and now supports WorldScript, too. (In combination with various foreign
language kits, WorldScript enables users to create foreign language documents.)
Other features of note are a new mail merge function and an HTML translator for
creating documents for the World Wide Web. (See Chapter 23 for more on the
World Wide Web.)

Overall, ClarisWorks 4 provides a robust set of features that enable the novice user to
grow with the program. More experienced users will quickly put the powerful feature
set to use. But most of all, just about everyone will appreciate the fact that they can get
all of this functionality without having to buy a bigger hard disk or more memory.

Microsoft Works (CS)

Microsoft Works 4 ($55 disk version; $80 CD version, includes Microsoft Bookshelf)
addresses some major problems with the previous version. In fact, some users of
Works 3 “backtracked” to version 2 because they preferred the way some of the fea-
tures in that version worked. Works 4 integrates its modules using Microsoft’s Object
Linking and Embedding (OLE) technology. This approach works well; you simply click
a button and draw a rectangle to, say, insert a spreadsheet in a word processor. You can
then edit the embedded object by double-clicking it, and you can also embed objects
from other OLE programs within Works. (OLE is Microsoft’s version of the same
type of technology Apple is introducing with OpenDoc, described in Chapter 3.)

Microsoft beefed up the software with plenty of new features, such as a slide show; a
tool for creating tables; an equation editor for editing equations with mathematical
symbols and subscripts; an AutoSum button for calculating totals automatically;

multi-level database sorting; and drag-
and-drop editing that lets you move or
copy a selection by just dragging it to
the desired location. It ships with a
selection of clip art and a Gallery for
organizing clip art images, and it now
comes with about 36 file-conversion
filters.

Works 4 also adds a new calendar and
address book, as well as a new paint tool
that has features such as gradient fills,
rotation, filters for creating special
graphical effects, and support for Adobe
Photoshop plug-in tools and filters.
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To choose a module in Microsoft Works 4, you click on an option
in the opening dialog box. Because all the modules are integrated,
it’s easy to share data among the word processing, database,
spreadsheet, and drawing modules and to make sure that changes
made to information in one module are reflected in the others.



Microsoft’s WordArt includes TrueType fonts and provides tools for different shadow
effects, shapes, and text and line rotations. You can also use WordArt to create fancy
headlines and banners.

Works 4 offers some features that simplify common tasks such as writing letters, gen-
erating reports, and designing newsletters. A feature called WorksWizards helps create
documents such as greeting cards and newsletters by posing simple questions that users
answer. Almost 40 stationery documents templates (called AutoStart in Works) provide a
quick starting point for creating different types of documents (such as a Grade Book,
Cash Flow Projection, and Home Inventory) designed for teachers, business users, and
home users.

Microsoft Office (SS)

Microsoft Office ($500) combines three best-selling Microsoft applications in one
convenient package: Microsoft Word 6 (word processing), Excel 5 (spreadsheets), 
and PowerPoint 4 (presentations). Because many businesses have standardized on
Word and Excel, buying Office is a commonsense move. It costs only a little more
than the combined prices of Word and Excel. As a bonus, Microsoft tosses in a single
workstation license for Microsoft Mail (although server software must be purchased
separately), as well as the ability to query databases.

Even though Office contains only three programs (plus a
single workstation license for Microsoft Mail), a complete
installation requires massive amounts of disk space—over
90MB! Office comes with a thorough setup program that
you use to install, remove, or reconfigure its components.
And it’s a good thing because Office is finicky about how it’s
set up. If you move or rename any folders or forget to
enable any of its two dozen or so extensions, there’s a good
chance that you’ll receive a nasty surprise.

Because Microsoft Office is billed as an integrated package,
you may well be wondering what this integration consists of.
Information can be shared between applications by standard
Mac methods: copy and paste, Publish and Subscribe, and
importing. None of these techniques, however, is new or
earthshaking. Office provides two additional data-sharing

techniques: embedding and linking. Suppose, for example, you want to include an Excel
chart in a Word document. If you embed the chart in the Word document, no link is
kept with the spreadsheet in which it was created. But if you ever need to edit the
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Microsoft Office adds its own
ever-present icon to the menu
bar. Click it to expose a menu
from which you can launch
installed Microsoft applications,
as well as other programs that
you’ve added to the menu.



embedded chart, you can just double-click it. Doing so launches Excel and opens the
original spreadsheet. Linking, on the other hand, works like Publish and Subscribe:
When you link an object (such as a chart) and later edit it, all linked copies are auto-
matically updated.

Do-it-yourselfers will be excited by the package’s new scripting capabilities. Word 6
includes a macro recorder, as well as its own scripting language called WordBasic
(long available in Word for Windows). And you can now script Excel using the Visual
Basic language. (At some point in the near future, all Microsoft applications will be
scriptable using Visual Basic, so here’s your chance to get a head start.)

Other important new features include the following:

• Drag-and-Drop support (within and between programs)

• OLE (Object Linking and Embedding) support

• AutoCorrect (a revised glossary feature for inserting lengthy text strings and auto-
matically correcting common typos and misspellings)

• AutoFormat (choose from a set of document formatting styles)

• Wizards (step-by-step guidance for common tasks such as making charts, tables,
mailing labels, and designing presentations)

• Improved table handling and formatting

• Excel’s “drag and plot” (automatic chart modification by dragging data)

• Workgroup features for collaborating on documents over a network

• TipWizard (watches you work and offers suggestions for easier, more efficient ways
to accomplish tasks)

One of the main selling points for Office is its cross-platform compatibility. If your
business has standardized on these Microsoft applications, you can readily share 
your data between Macs and PCs, and users can easily switch from one platform to
another (the programs work the same). Of course, the main reason for buying
Microsoft Office rather than ClarisWorks or Microsoft Works is power, power,
power! If you make your living as a writer or a number cruncher, you won’t have 
to worry about constantly bumping into the limitations of typical integrated packages.
If Word, Excel, and PowerPoint can’t do it for you, it probably can’t be done.
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ClarisWorks Tips
These tips are for ClarisWorks 4, although many of them will also work in earlier
versions of ClarisWorks.

General

Saving memory (CR/SS). ClarisWorks can run short of memory during long com-
munications sessions or when using the paint environment. Here are a few ways to
maximize memory when using these document types:

• Use the Communication preferences to change from an unlimited scrollback area
to one of a small fixed size, and use the Capture Text command to store communi-
cations data in a file on your disk instead of in memory.

• To free up more memory for paint documents, use the Resolution & Depth com-
mand to set the pixel depth to Black & White, 4 colors, or 16 colors, instead of
using thousands or millions of colors.

• Because ClarisWorks’ Paint environment demands a lot of memory, Claris recom-
mends increasing the memory allocation before using it.

Which shortcut is which? (CR/SS). If you can’t remember what each button on the
Shortcuts palette does, you can display the shortcuts as names instead of icons. Just
change the Shortcuts preferences to Show Names. To find out what one specific
button does, choose Edit Shortcuts, click the button in the dialog box, and look in the

Description area.

If you regularly forget what the buttons mean, you
can also set the Automatic Balloons option in the
Shortcuts preferences. Then whenever the cursor
rests over a Shortcuts button for a second or two, a
help balloon appears that identifies the button.

Recycling macro keys (CS). If you create lots of macros and find yourself running
out of macro keys, try assigning macros to specific ClarisWorks document types
instead of creating macros that work everywhere. For example, you could use
oz2 to double-space a word processing document, and use the same keys to
choose a fixed-number format with two decimal places in the spreadsheet. Just be sure
to check the document type you want in the Record Macro dialog box as you define
each macro.
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ClarisWorks’ Shortcuts palette gives you access to
commonly used functions (represented by icons)
with one mouse click.
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Wrapping text around a graphic (CS). You can wrap text around a graphic even
when you’re not in the word processing environment. Turn Frame Links on for the
frame containing your text. ClarisWorks will wrap text around graphics that were
created with the drawing tools or were pasted in PICT format. If you need to wrap
around other objects (e.g., bitmapped graphics, EPS files, and so on), draw a border-
less white object that is slightly larger than your graphic and move it behind the
pasted-in graphic (Send to Back).

Creating slide presentations
(CS). A nice feature in ClarisWorks
is the ability to create on-screen
slide presentations. There are sev-
eral different ways to do this; in fact,
any environment in ClarisWorks
can be turned into a slide presenta-
tion. Some of the less obvious ways
to do this include:

• From the Draw environment,
insert text frames and organize
them as outlines. Use outline
formats to define the fonts, sizes,
and styles for each level in your presentation. (You can have multiple levels, so the
first level could be 36-point bold Times; the second level 30-point Times Roman,
and so on.) [If you need help, you can use the Presentation Assistant to quickly design basic
presentations.—SS]

• From the Database environment, set up a Database layout with a title and a few
bullet points. You can then enter data to create a very quick presentation.

Creating predefined formats (CS). You can create predefined document formats
such as a fax cover sheet, a standard memo, or a presentation. The format will have all
the type styles and other formatting you’ve defined. Choose Save As from the File
menu and click the Stationery radio button. This will save a template with your for-
matting; you can then select it whenever you create a new document of that type.

Creating default formats (CS/SS). You can create a default document for each of the
ClarisWorks environments; then every time you make a new document in that envi-
ronment, it will automatically default to your predefined formatting. To do this, create
a stationery document and, for the word processor, name it ClarisWorks WP Options
(for the draw module, substitute DR; for the paint module, PT; for the database module,
DB; for the spreadsheet module, SS; and for the communications module, CM). 
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You can create slides like this in ClarisWorks’ draw module using the
Presentation Assistant.
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In ClarisWorks 4, you must keep these documents inside the ClarisWorks Stationery
folder (which is chosen automatically when you click the Stationery radio button in the
Save As dialog box).

Automating text searches (SS). To conduct a search without having to deal with
the normal Find/Change dialog box, select the search text in the document (Apple
Computer, for example), and then choose Find Selection rather than Find/Change.
ClarisWorks takes you directly to the next instance of the selected text string.

Using AppleScripts (JL/SS). Several AppleScript examples are included in the
ClarisWorks Scripts folder of ClarisWorks 4. For example, by dragging files or folders
onto the Convert Documents AppleScript icon, you can quickly convert foreign files
(such as Microsoft Word documents) to ClarisWorks 4 format. Read the About the
AppleScripts document for instructions.

In the same folder, Claris also includes a database of available AppleScript commands
(called ClarisWorks AppleEvents List) so you can get started writing your own scripts.
This is a great way to get started with AppleScript.

Word Processing

Inserting graphics (SS/CS). There are two ways to add graphics to a word process-
ing document:

• If the cursor is an I-beam and you have a blinking insertion point in your docu-
ment, pasting will bring in the graphic as a (usually) large character in the line with
the previous characters.

• If you Show Tools, select the Pointer tool, and then choose Paste from the Edit
menu, your graphic will appear as a completely separate object from the text.
Inserting or changing text will not affect its position. You can then choose Text
Wrap from the Options menu and wrap the text around your graphic.

The second method is preferable if you’re trying to do any kind of page layout. Use the
first method if you want to make sure the graphic stays tied to a particular text section.
[Rather than leave the graphic embedded in the middle of a line of text—usually resulting in
horrid between-line spacing—you can use the first method and put the graphic on its own line.
You can then apply alignment options (left or centered, for example) and set the line spacing
before and after (choose the Paragraph command from the Format menu) to position the
graphic exactly where you want it.—SS]

Toggling invisible characters on and off (CS). Pressing z; toggles invisible
characters, such as paragraph and return symbols, on or off.
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Creating a custom style (JL). You can create your own custom styles to help you
quickly and consistently format documents. Choose Show Styles from the View
menu, and click New. Choose the type of style you want to create (basic, paragraph,
outline, and so on) and then click OK. You can modify and add attributes by clicking
the Edit button and then selecting options from the text ruler or menus. When you’ve
got the style the way you want it, click Done. You can later reuse the style by either
creating a stationery document or by exporting the style and then importing it into
your other documents.

Creating tables (CS). You can easily create tables in a word processing document by
using spreadsheet frames. Like a graphic, the table can be free-floating (easily moved
around within the document) or tied to a specific section of text.

Paint and Draw

Using a draw document for page
layout (CR). It may seem best to use the
word processor for newsletters, but cre-
ating text frames in a Draw document
gives you much more flexibility for
arranging blocks of text and graphics on
a page. After you create text frames, you
can link them (so text flows from one
frame to another in the same story). And
because frames are objects, you can
select them and use the draw document’s
alignment commands to precisely align
columns and graphics.

Using a draw document for multipage printing (CR). Paint documents in
ClarisWorks can be only one page long. To create a multipage paint document, open
a draw document, add the number of pages you want, and then create one or more
paint frames on each page.

Selecting images precisely without the Lasso (CR). Using the Lasso tool is the
most common way to select an image without selecting white space around it. But you
can do the same thing more quickly by holding down the z key while dragging 
the selection rectangle around the image(s) you want to select. To select all the images
on a document without any white space around them, double-click on the selection
rectangle tool while holding down the z key.
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You can use text frames in a ClarisWorks draw document to
create page layouts.
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Spreadsheet

Saving paper (CS/SS). Before printing a spreadsheet, drag to select the range you
want to print, choose Set Print Range from the Options menu, and click OK. At this
point, select Page View from the View menu to see how it will print. Because you can
keep working in this view, you can adjust the column widths so pages break the way
you want them to.

Making big chart changes (CR). If the chart formatting options in the spreadsheet
aren’t flexible enough for you, copy the chart to a draw document, select it, and then
use the Ungroup Picture command to break up the chart into its components. After
you use Ungroup Picture, you can select different chart elements like the legend or a
group of bars, and then use the Ungroup command to break up elements further. For
example, you could ungroup a series of bars to select and change the fill pattern in one
bar. Unfortunately, once you paste a chart into a draw document, it becomes unlinked
from the original spreadsheet, so make sure the chart shows exactly the data you want
before modifying it in a draw document.

Inserting multiple rows or columns (CR). The Insert Cells command in the
spreadsheet takes awhile to work, and using it repeatedly to insert several rows or
columns seems particularly slow. You can speed things up by selecting as many rows
or columns as you want to insert and then using the Insert Cells command.
ClarisWorks will then insert as many rows or columns as you have selected.

Moving data between databases and spreadsheets (CS). You can move data
from a database to a spreadsheet—or vice versa—by selecting all of the records (by

choosing Select All from the Edit menu)
and copying that data into a new spread-
sheet. You can go the other direction as
well, but you’ll need to re-create the
field names and definitions.

Shortcuts for formatting spread-
sheets in presentations (CS). After
you put data into a spreadsheet, you can
do a lot to dress it up and format it
exactly the way you want it. In the
Shortcuts palette, you can access com-
mands to automatically size rows and
columns, turn on and off row and col-
umn headers, and specify whether grid
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For better-looking spreadsheets that are suitable for presen-
tations, use the Shortcuts palette to turn grids on and off and 
to automatically size rows and columns. You can also insert
graphics and text balloons.
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lines should be solid or dashed, for example. Because it’s still a spreadsheet, you can
also make a chart out of it.

Database

Using two windows to design layouts (SS). One of the frustrating things about
creating layouts is that you constantly have to switch back to Browse mode to see the
effects of your changes. That’s where the New View command comes in handy. Next
time you need to change a layout,
start by selecting New View from the
View menu, and then select Tile
Windows from the same menu. Make
sure that a filled-in record is dis-
played, and then switch to Layout
mode in one of the two windows. As
you change the layout—by moving
and resizing fields, changing field
formatting, and so on—you can
instantly see the effects of your mod-
ifications in the other window.

Setting up labels (CS). When set-
ting up labels, getting fields to line up
next to each other can be tricky. Say you have two fields: First and Last. You’d like
Last to slide next to First when it prints. Three things must be true: the tops of the
fields must be exactly lined up (use 400 percent view so you can see what you’re doing,
or use the Align Objects command in the Arrange menu); the fields can be very close
but they cannot touch; and the height of the fields cannot increase as you go from left
to right.

Creating reusable sorts, finds, and reports (JL). ClarisWorks 4 lets you save
search and sort criteria so you can use them over and over. Click the Search or Sort
tool in the toolbar on the left and then choose the New command from the pop-up
menu. After giving a name to the action, generate the search or sort. It is now record-
ed for use at a later time. You can string these commands together by using the
FastReport function that lets you select a layout, search instructions, sort instructions,
and then print the resulting report.
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When modifying a layout, you can see the effects of changes—as
they are made—if you keep one window open in Layout mode
(top) and a second window open in Browse mode (bottom).
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Communications

Capturing sessions (CS). Capturing information in a session is most reliably done
with Capture Data rather than by saving the communications document itself. Saving
the document is best used only to retain the settings for calling a particular service or
bulletin board. To keep the file small, save it before using it.

Microsoft Works Tips
These tips are for Microsoft Works 4, although many of them will also work in 
Works 3.

General

Embedding objects (CS). You can add a graphic, spreadsheet, or table to a docu-
ment without ever leaving the word processor (actually, the same holds true for any
document—not just word processing documents). From the tool palette, select the
appropriate tool by clicking on it, and then draw a rectangle where you would like 
the object to appear in your document. The appropriate tools for the object you 
have chosen will appear. To edit that object later, simply double-click it. Using the
same steps, you can add any number of OLE objects, including a Microsoft Excel
spreadsheet or chart, a Microsoft Word document, WordArt, clip art, or an Equation
Editor formula.

Using AddressBook for fast searches (CS). If you type a name in the word proces-
sor and then open the AddressBook, the name will automatically appear in the Match
Records dialog box, ready to be matched to a record in the database.

Opening multiple documents as one Workspace (CR). If you regularly work
with two or more Works documents at a time, you can save the documents as a set,
called a Workspace, so they’re easier to open. Just open all the documents you need to
work with (a database file and a form letter, for example), and then use the Save
Workspace command on the File menu to save the documents with a project name.
Works creates a workspace document. The next time you double-click on the workspace
document, all the documents saved with it will open at the same time.

Getting to Balloon Help (CS). Hold down szo to get instant access to
Balloon Help for descriptions of the items on the toolbar and palette.

Microsoft Works Tips 347

HOT T I PS



Word Processing

Zooming (CS). Formatting changes and alignment of graphics and text will be a lot
easier to see if you zoom in on your document. Documents can be magnified up to
800 percent using the magnifying glass buttons on the ribbon, or you can zoom to a
particular percentage by clicking on the down arrow at the bottom of the window.
The percentage will show next to the arrow.

Automating search text entry (CS). To speed search and replace, select text before
you choose the Find or Replace command (both on the Search menu). The selected
text is automatically entered into the Find What text box.

Optimizing spell checking (CR). You can make Works’ spelling checker run a little
faster by resetting some of the standard spelling options. First, choose the Spelling
command from the Document menu and click the Options button. Then click the
Ignore Words In All Caps and Ignore Words With Digits boxes (so an X appears in
each of them). If you don’t need Works to help you with alternate spellings, click the
Always Suggest box to remove the checkmark from it—it takes extra time for Works to
look up and display alternate spellings.

Accessing the thesaurus quickly (CR). You can use Works’ built-in thesaurus to
find synonyms whenever you want, not just when you select a word in a document.
Just choose the Thesaurus command from the Document menu, type the word whose
synonyms you want to look up into the With box, and click the Look Up button.

Paint and Draw

Resizing paint frames (CS). While resizing a paint frame (with the frame handles),
hold down the z key. This resizes the frame without scaling (and distorting) the
contents.

Making a discontiguous selection (CS). If you need to change the colors, for
instance, in some but not all parts of an image, you can select several different (dis-
contiguous) sections of a paint frame by pressing s while using the Selection tool.

Selecting colors (CS). Hold down the z key and click on the paint selection with
the Wand tool to select all occurrences of a particular color throughout an image.

Rotating text (CS). You can rotate text created in the Draw module by any degree
by clicking on the Rotate Text button on the toolbar and selecting the number of
degrees for rotation.
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Rearranging pages (CS). Instead of using Copy, Cut, and Paste to move pages of
text in a Draw document, you can easily rearrange pages by dragging and dropping
them in the Page Sorter. This view shows all the pages in a Draw document side by

side in a thumbnail preview. Select
Page Sorter from the Views submenu
of the View menu.

Creating master slide elements
(CS). Use the Master Slide feature to
automatically insert a graphic or title
onto all slides in a presentation. Access
the Master Slide through the toolbar,
or in the Format menu select Master
Slide Attributes, or in the View menu,
scroll to Views.

Working along straight lines (CR). You can force Works to draw straight lines at
45- or 90-degree angles by holding down s as you draw with the Straight Line tool.
To move an object along a straight 45- or 90-degree line, select the object and hold
down s as you drag it.

Embellishing lines with arrows (CR). You can add an arrow to one or both ends
of any straight line you draw in Works. To move an arrow from one end of a line 
to the other, just flip the line around: Select the line, choose Rotate from the Draw
menu, click the Horizontal Flip or Vertical Flip checkboxes, and then click the 
OK button.

Creating identical columns (CS/CR). Instead of trying to re-create similar-sized
columns one at a time (and then spending time trying to align them), you can create
multiple (one, two, three, or four) identically sized columns by clicking on the 
New Columns button on the Column tool in the floating tool palette. After you’ve
selected the number of columns you want, drag out a rectangle on the page and 
Works will automatically create the desired number of equally sized columns within
that rectangle.

To create a group of identical columns in Works 3, make one column the size you
want, select it, duplicate it, and then drag the duplicate to the proper location. This is
much faster than trying to draw identical columns from scratch.
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Spreadsheet

Selecting areas to be printed (CS). If you have more than a single cell selected in
a spreadsheet, when you choose the Print command, Works will print the range you
have selected, not the entire spreadsheet.

Moving spreadsheet cells in groups (CR). By taking advantage of the drag-and-
drop functionality added in Works 4, you can move a range of cells faster and more
easily than you can with the Move command: Simply select a range of cells, click near
the edge of the selection when the cursor becomes a pointer, and then drag the selec-
tion to the desired new location. To move a group of cells from one place to another
in Works 3, select the cells, hold down z and o at the same time, and click on
the upper-right cell in the area where you want the selection to move.

Using ranges in formulas (CR). After you begin a formula, you can specify a range
of cells by simply holding down the mouse button and dragging the mouse pointer
across a group of cells. As you do this, the range address appears in the formula.

Getting to cell notes (CR). Cell notes are incredibly handy for inserting backup or
explanatory information about numbers in your spreadsheets. To open a cell note
quickly, hold down the z key and double-click on the cell whose note you want 
to display.

Creating new charts (CR). Instead of using the New Chart command to make a
chart, select the data you want in the chart, click the Chart tool in the tool palette, 
and then hold down the mouse button as you drag an outline where you want the
chart to appear. When you release the mouse button, the chart will be drawn inside
the outline.

Database

Counting records (CS). You can automatically count the number of records in a field
by creating a serialized field. To do that, choose Field from the Insert menu and click
on Serialized in the dialog box that appears.

Printing selected records (CS). Use the Mark Records for Printing option (in the
Tools menu) to print selected records. For instance, if the printer misprints a few
labels (or you put them on the wrong envelope), you can mark those records to be
reprinted.
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Creating new fields (CR). When you’re in Design view and need to add a new field
to your file, hold down z and then press the mouse button to drag an outline where
you want the field to appear. When you release the mouse button, the New Field dia-
log box will appear, and you can then type a name for the new field. (In Works 3, oddly
enough, you don’t have to hold down the z key.)

Changing field names and formats (CR). The fastest way to make field name or
format changes is to double-click anywhere on the field in List or Design view. This
brings up a Field Format dialog box where you can change the field name or format.
In Works 3, changing the field name and its format requires you to go to two differ-
ent dialog boxes: You’ll need to double-click on the field’s name to display the Field
Name dialog box and double-click on the field’s data space to display the Field Format
dialog box.

Entering data in a form (CR). When you enter data on a Data view form, the selec-
tion moves from one field to another in the order in which you added fields to the
form. In Works 4, to change the tab order all you have to do is choose Tab Order from
the Format menu. In other versions, make a new form and add the fields in the tab
order you want.

Communications

Automating sign-on (CS). Microsoft Works will record your sign-ons to automati-
cally log onto commonly used services. To record a sign-on sequence, select Sign-On

from the Tools menu, and then select
Record from the submenu. When you fin-
ish your recording, you will be prompted
to name your sign-on sequence and save
it. In future communications sessions, you
can simply select Play and your script
name, and Works will automatically sign
onto the service.

Tracking time and costs (CS). Works
now has a timer that keeps track of time
spent on-line and the charges for the
session. Make sure to reset the timer and
charges log whenever you begin a new
communications session.
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sign-on script for you.
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Optimizing communications documents (CR). It takes forever to close a com-
munications document when you have Works set to use an overflow area. To speed
up communications documents, choose Preferences and click None in the Overflow
Area Size box, and then click the Always Capture Text option.

Continuing to work during file transfers (CR). Works can maintain a connec-
tion during a long file transfer even if you activate another Works document. Just start
sending or receiving, and then switch to the other document and continue working.
When the file transfer is complete, Works will beep twice to let you know so that you
can return to your communications document.

Calendar

Changing appointments (CS). Move appointments quickly by using drag and drop
(instead of deleting and retyping the information). Select the appointment to be
moved, hold down the mouse button as you move the selected text to the new loca-
tion, and then release the mouse button to move the appointment.

Keeping track of To Do items for individual projects (CS). Display all the
To Do items for a particular project by assigning each item a keyword (such as Report,
Meeting, and so on) on which you can sort.
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